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spectral imaging microscopy modality we have developed, called excitation-scanning hyperspectral imaging.  

In the manuscript, we provide details regarding set up of an excitation-scanning hyperspectral imaging 

microscope system, configuration of software for running the system, calibration of the system to NIST-

traceable response, and the procedure for acquiring experimental data using the system.  In prior work, we 

have demonstrated that the approach of excitation-scanning hyperspectral imaging microscopy can provide 

10-100X increased signal and imaging speed, compared to prior emission-scanning hyperspectral imaging 
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SUMMARY: 25 

Spectral imaging has become a reliable solution for identification and separation of multiple 26 

fluorescence signals in a single sample and can readily distinguish signals of interest from 27 

background or autofluorescence. Excitation-scanning hyperspectral imaging improves on this 28 

technique by decreasing the necessary image acquisition time while simultaneously increasing 29 

the signal-to-noise ratio. 30 

 31 

ABSTRACT: 32 

Several techniques rely on detection of fluorescence signals to identify or study phenomena or 33 

to elucidate functions. Separation of these fluorescence signals were proven cumbersome until 34 

the advent of hyperspectral imaging, in which fluorescence sources can be separated from each 35 

other as well as from background signals and autofluorescence (given knowledge of their 36 

spectral signatures). However, traditional, emission-scanning hyperspectral imaging suffers 37 

from slow acquisition times and low signal-to-noise ratios due to the necessary filtering of both 38 

excitation and emission light. It has been previously shown that excitation-scanning 39 

hyperspectral imaging reduces the necessary acquisition time while simultaneously increasing 40 

the signal-to-noise ratio of acquired data. Using commercially available equipment, this 41 

protocol describes how to assemble, calibrate, and use an excitation-scanning hyperspectral 42 

imaging microscopy system for separation of signals from several fluorescence sources in a 43 

single sample. While highly applicable to microscopic imaging of cells and tissues, this 44 
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technique may also be useful for any type of experiment utilizing fluorescence in which it is 45 

possible to vary excitation wavelengths, including but not limited to: chemical imaging, 46 

environmental applications, eye care, food science, forensic science, medical science, and 47 

mineralogy. 48 

 49 

INTRODUCTION: 50 

 51 

Spectral imaging may be performed in a variety of ways and is referred to by several terms1–4. 52 

In general, spectral imaging refers to data acquired in at least two spatial dimensions and one 53 

spectral dimension. Multispectral and hyperspectral imaging are most often distinguished by 54 

the number of wavelength bands or whether the spectral bands are contiguous1. For this 55 

application, hyperspectral data is defined as spectral data acquired with contiguous wavelength 56 

bands achieved by spacing of center wavelengths no less than half the full width at half 57 

maximum (FWHM) of each bandpass filter used for excitation (i.e., 5 nm center wavelength 58 

spacing for bandpass filters with 14–20 nm bandwidths). The contiguous nature of the data 59 

bands allows for an oversampling of the dataset, ensuring that Nyquist criteria are satisfied 60 

when sampling the spectral domain. 61 

 62 

Hyperspectral imaging was developed by NASA in the 1970s and 1980s in conjunction with the 63 

first Landsat satellite5,6. Collecting data from several contiguous spectral bands allowed the 64 

generation of a radiance spectrum of each pixel. Identifying and defining the radiance spectrum 65 

of individual components made it possible to not only detect surface materials by their 66 

characteristic spectra, but it also allowed for the removal of intervening signals, such as 67 

variations in the signal due to atmospheric conditions.  68 

 69 

The concept of detecting materials using their characteristic spectra was applied to biological 70 

systems in 1996 when Schröck et al. used combinations of five different fluorophores and their 71 

known spectra to distinguish labeled chromosomes in a process termed spectral karyotyping7. 72 

This technique was elaborated upon in 2000 by Tsurui et al. for fluorescence imaging of tissue 73 

samples, using seven fluorescent dyes and singular value decomposition to achieve spectral 74 

separation of each pixel into linear combinations of spectra in the reference library8. Similar to 75 

their remote sensing counterparts, the contribution of each known fluorophore can be 76 

calculated from the hyperspectral image, given a priori information of the spectrum of each 77 

fluorophore.  78 

 79 

Hyperspectral imaging has also been used in the areas of agriculture9, astronomy10, 80 

biomedicine11, chemical imaging12, environmental applications13, eye care14, food science15, 81 

forensic science16, 17, medical science18, mineralogy19, and surveillance20. A key limitation of 82 

current fluorescence microscope hyperspectral imaging systems is that the standard 83 

hyperspectral imaging technology isolates fluorescence signals in narrow bands by 1) first 84 

filtering the excitation light to control sample excitation, then 2) further filtering emitted light 85 

to separate the fluorescence emission into narrow bands that can later be separated 86 

mathematically21. Filtering both the excitation illumination and emitted fluorescence reduces 87 

the amount of available signal, which lowers the signal-to-noise ratio and necessitates lengthy 88 



acquisition times. The low signal and lengthy acquisition times limit the applicability of 89 

hyperspectral imaging as a diagnostic tool.  90 

 91 

An imaging modality has been developed that makes use of hyperspectral imaging but boosts 92 

the available signal, thereby reducing the necessary acquisition time21,22. This new modality, 93 

called excitation-scanning hyperspectral imaging, acquires spectral image data by varying the 94 

excitation wavelength and collecting a broad range of emitted light. It has been previously 95 

shown that this technique yields orders of magnitude increases in signal-to-noise ratio 96 

compared to emission scanning techniques21,22. The increase in signal-to-noise ratio is largely 97 

due to the wide bandpass (~600 nm) of emission light detected, while specificity is provided by 98 

filtering only the excitation light instead of the fluorescence emission. This allows all emitted 99 

light (for every excitation wavelength) to reach the detector21. Additionally, this technique can 100 

be used to discriminate autofluorescence from exogenous labels. Furthermore, the ability to 101 

reduce acquisition time due to increased detectable signal reduces the danger of 102 

photobleaching as well as allows spectral scans at an acquisition rate that is acceptable for 103 

spectral video imaging. 104 

 105 

The goal of this protocol is to serve as a data acquisition guide for excitation-scanning 106 

hyperspectral imaging microscopy. In addition, descriptions are included that help to 107 

understand the light path and hardware. Also described is the implementation of open-source 108 

software for an excitation-scanning hyperspectral imaging microscope. Finally, descriptions are 109 

provided for how to calibrate the system to a NIST-traceable standard, adjust software and 110 

hardware settings for accurate results, and unmix the detected signal into contributions from 111 

individual components. 112 

 113 

PROTOCOL: 114 

 115 

1. Device set-up 116 

 117 

1.1) Light source: select a broad-band spectral light source with high power output and high 118 

collimation (a 300 W Xe arc lamp was used for these studies). 119 

 120 

1.2) Shutter (optional): add a shutter to the optical path to reduce photobleaching for time-121 

lapse imaging. 122 

 123 

1.3) Tunable filter system: incorporate a mechanical tuning assembly and thin-film tunable filter 124 

(TFTF) set to enable the desired wavelength-adjustable excitation range (e.g., 340–550 nm). 125 

 126 

1.4) Microscope: use an inverted fluorescence microscope including a motorized dichroic filter 127 

turret and controller. 128 

 129 

1.4.1) Fluorescence filter cube: assemble a long-pass fluorescence filter cube. For best results, 130 

choose a dichroic mirror and long-pass emission filter at the same wavelength to achieve 131 

optimal separation of excitation from emission light (e.g., 495 nm). 132 



 133 

1.4.2) Objective: use an appropriate apochromatic objective to ensure uniform focus over the 134 

wavelength range used for the experiment (a 60x water objective was used for this study). 135 

 136 

1.4.3) Automated stage (optional): use an automated stage for rapid sampling of multiple fields 137 

of view and/or very large fields through image stitching. Calibrate the stage with the objective 138 

and the camera. 139 

 140 

1.5) Camera: select an appropriate camera to achieve the spatial resolution, sensitivity, and 141 

noise requirements of the experiment (this system utilized a high-sensitivity sCMOS camera). 142 

 143 

2. Acquisition software 144 

 145 

2.1) Choose a software package that allows independent control of each hardware component, 146 

such as Micro-Manager. 147 

 148 

2.1.1) Creating the configuration file: the configuration file is a saved set of instruments and 149 

instructions that Micro-Manager will load to operate the system’s hardware. To create a 150 

configuration file, click Tools > Hardware Configuration Wizard. 151 

 152 

2.1.1.1) In step 1, click Create new configuration > Next to continue. Note that the user may 153 

choose to modify or explore existing configuration if one is available already. 154 

 155 

2.1.1.2) In step 2, browse the Available Devices list to find the devices to control through 156 

Micro-Manager, such as the microscope, lamp, stage, shutter, and camera. When highlighted, 157 

click the Add… button to add the device to the installed devices list. This will open a new 158 

window. 159 

 160 

2.1.1.2.1) Designate the device’s label in the Label box. (e.g., sCMOS camera) 161 

 162 

2.1.1.2.2) Under Value, select the appropriate COM port for each device. This will cause a list of 163 

device properties to appear in the bottom of the window. 164 

 165 

2.1.1.2.3) Leave the device properties at their default settings. Note that custom values for 166 

each device property may be entered as desired. 167 

 168 

2.1.1.2.4) When each device is added, click the Next button to continue to the next step. Note 169 

that if any devices are left out or need to be changed, the configuration file can be modified 170 

later as described in step 2.1.1.1. 171 

 172 

2.1.1.3) In step 3, use the drop-down menus to select the default camera, shutter, and focus 173 

stage. If auto-shutter is desired, click the Check box below the focus stage drop-down list. If the 174 

focus direction of the Z-stage is known, select it from the drop-down list under Stage focus 175 

directions (advanced). Otherwise, leave the default as Unknown. 176 



 177 

2.1.1.4) In step 4, double-click the boxes under the Delay [ms] heading to set delays associated 178 

with the automated devices such as delays of 100 ms for the lamp, stage, and shutter, and a 179 

250 ms delay for commands to the mechanical tuning assembly to account for the mechanical 180 

switching time between filters. 181 

 182 

2.1.1.5) In step 5, assign labels for the state devices. The configuration for the excitation-183 

scanning microscope system uses labels in the filter block to identify each fluorescence filter 184 

cube (e.g., state 0 corresponds to the label Bright, the empty filter cube used during bright-field 185 

imaging; while state 3 corresponds to the label 495 nm and custom 495 nm dichroic filter cube 186 

used to separate excitation and emission light at 495 nm). Labels are also used in the 187 

mechanical tuning assembly to store the switching commands for each excitation wavelength 188 

(e.g., state 0 corresponds to the 340 nm excitation wavelength tuning command for the 189 

mechanical tuning assembly). 190 

 191 

2.1.1.6) In step 6, click the Browse button next to the Configuration file box to choose a save 192 

location and file name for the configuration file. Click finish to save the configuration file. 193 

 194 

2.1.2) Startup groups and presets: Micro-Manager can store different groups within each 195 

configuration file to activate or change a subset of the hardware. For example, a “system 196 

startup” group and preset combination will store default settings such as binning size and 197 

readout rates for the camera. 198 

 199 

2.1.2.1) Create a group (e.g., System) by clicking + in the main window in the Group subsection.  200 

 201 

2.1.2.2) Check any Use in Group? boxes inside the group that will require a default value to be 202 

set (e.g., binning in the associated default camera). 203 

 204 

2.1.2.3) Create a new preset (e.g., “Startup”) by clicking + in the main window in the Preset 205 

subsection. 206 

 207 

2.1.2.4) Each box checked in step 2 will appear as a preset option here. Choose a default value 208 

to be loaded for each box checked. 209 

 210 

2.1.3) Group and presets for excitation wavelengths: Micro-Manager treats each excitation 211 

wavelength as its own channel with it its own wavelength switching command; therefore, each 212 

must be saved as its own preset. 213 

 214 

2.1.3.1) Create a new group to contain a set of desired excitation wavelengths (e.g., “495 nm 215 

dichroic”) 216 

 217 

2.1.3.2) Check the Use in Group? box named Label corresponding to the VF-5 device. 218 

 219 

2.1.3.3) Create a new preset named for each excitation wavelength (e.g., “340 nm”). 220 



 221 

2.1.3.4) Assign to each preset the appropriate property name and preset value (e.g., property 222 

name: “Label”; preset value: “340 nm”). 223 

 224 

2.1.4) Multi-dimensional acquisition tool: click Multi-D Acq. near the top left of the Micro-225 

Manager window to open a customizable tool to use for capturing an image of the sample at 226 

each excitation wavelength with the click of a single button. There are several customization 227 

options to construct the acquisition exactly as desired. 228 

 229 

2.1.4.1) Timepoints (not used in this example): for studies with no time-lapse component, leave 230 

the box unchecked. If time-lapse studies are desired, check this box. If checked, enter the 231 

number of times to perform the rest of the acquisition settings in the Number box. Set the time 232 

between successive acquisitions by entering the duration in the Interval box and choose the 233 

proper unit (milliseconds, seconds, or minutes; usually seconds). 234 

 235 

2.1.4.2) Multiple positions (XY; not used in this example): for studies of a single XY position, 236 

leave the box unchecked. If multiple XY positions are desired, check the box and click the Edit 237 

position list button to open a separate window. Move the stage to each desired location and 238 

click the Mark button to save that position in the software. Repeat until all desired XY positions 239 

are marked. Close this window to continue. 240 

 241 

2.1.4.3) Z-stacks (slides; not used in this example): for studies of a single Z position, leave the 242 

box unchecked. If multiple Z positions are desired, check the box. Move the stage to the desired 243 

beginning Z position and click the Set button next to the Z-start box. Move the stage to the 244 

desired ending Z position and click the Set button next to the Z-end box. Enter the desired step 245 

size (in microns) in the Z-step box. 246 

 247 

2.1.4.4) Channels: ensure that the Channels box is checked. Here, channels are the names given 248 

to the individual excitation wavelengths. Available “Channels” correspond to the “Groups” 249 

described in steps 2.1.2 and 2.1.3. 250 

 251 

2.1.4.4.1) Group: click the drop-down list to select a group from which to choose available 252 

excitation wavelengths (e.g., 495 nm dichroic). 253 

 254 

2.1.4.4.2) Click the Keep Shutter Open box to keep the shutter open between acquisitions for 255 

each channel. Note that the shutter will still close between successive spectral scans if this box 256 

is checked, assuming the autoshutter option is also selected in the main window. 257 

 258 

2.1.4.5) Click the New button to add channels to the acquisition list. Note that the Remove 259 

button can be used to remove any channels no longer desired and that Up and Down can be 260 

used to reorder any selected channel. 261 

 262 

 2.1.4.5.1) Ensure that the Use? checkbox is selected for each desired wavelength in the 263 

spectral scan. 264 



 265 

 2.1.4.5.2) Configuration: click the drop-down list under Configuration and choose the first 266 

wavelength in the desired spectral range (e.g., 340 nm). 267 

 268 

 2.1.4.5.3) Exposure: double-click the box under Exposure and input the desired exposure time 269 

for the selected wavelength (e.g., “100” for 100 ms). See section 5 (“Data Acquisition”) for 270 

suggestions to select appropriate exposure times. 271 

 272 

 2.1.4.5.4) Z-offset (not applicable in a spectral scan): leave this box blank (at 0) when 273 

performing a spectral scan. 274 

 275 

 2.1.4.5.5) Z-stack: ensure that this box is checked for each wavelength in the spectral range if 276 

performing a Z-stack. 277 

 278 

2.1.4.5.6) Skip Fr. (not applicable in a spectral scan): leave this box blank (at 0) when performing 279 

a spectral scan. Note that it may be useful to selectively skip frames in the event that one or 280 

few excitation wavelengths are significantly more powerful than others or if individual 281 

excitation wavelengths prove to be especially phototoxic. 282 

 283 

2.1.4.5.7) Color: leave this box blank when performing a spectral scan. Note that colors can be 284 

chosen for individual wavelength bands for data visualization purposes, but color is 285 

inappropriate for subsequent spectral unmixing. 286 

 287 

2.1.4.5.8) Repeat these steps until each desired excitation wavelength within the given spectral 288 

scanning range is added. 289 

 290 

2.1.4.6) Acquisition order: click the drop-down list to choose in which order the above options 291 

(2.1.4.1–2.1.4.5) will be performed. For spectral scans such as the one shown here, the 292 

acquisition order is simply Channel. Note that additional options appear as additional boxes are 293 

checked within the Multi-Dimensional Acquisition tool [timepoints, Multiple Positions (XY), and 294 

Z-stacks (slices)] and allow the choice of either position or time first, followed by either slice or 295 

channel. 296 

 297 

2.1.4.7) Autofocus (not used in this example): If Multiple Positions (XY) is selected, several 298 

different styles of autofocusing are available. Click the Options button and select an autofocus 299 

method from the drop-down list beside the close button. 300 

 301 

2.1.4.8) Summary: review this window for a summary of number of timepoints, XY positions, Z 302 

slices, channels, total number of images, total memory, scan duration, and acquisition order to 303 

ensure the listed information matches expected acquisition settings. 304 

 305 

2.1.4.9) Save images: ensure that this box is checked to save the data collected through use of 306 

the Multi-Dimensional Acquisition tool. 307 

 308 



2.1.4.9.1) Click the … button next to Directory root to choose a directory root in which the files 309 

will be saved. Name the directory root in a fashion that describes relevant details of the 310 

experiment (e.g., GCaMP Airway Smooth Muscle Cells). 311 

 312 

2.1.4.9.2) Enter a name in the box next to Name prefix that describes the current image 313 

acquisition (e.g. FOV1_100ms_60X_495nmDichroicFilter). It is advisable to create a name prefix 314 

that identifies the field of view and exposure time, as well as other relevant information such as 315 

the object and dichroic filter used. Note that the first image stack taken using these settings will 316 

be saved with “_1” following the name prefix. Any subsequent stack taken with the same 317 

directory root and name prefix will be saved with “_n”, in which “n” is the number of times a 318 

stack has been taken with this name in the directory. 319 

 320 

2.1.4.9.3) Click Separate image files to ensure the image generated at each excitation 321 

wavelength is saved. 322 

 323 

2.1.4.10) Save as: click the Save as… button near the top right of the Multi-Dimensional 324 

Acquisition tool to save these acquisition settings for easy future use. Note that the directory 325 

root and name prefixes will be saved, as well. 326 

 327 

2.1.4.11) Acquire: finally, click the Acquire! button to begin acquiring images according to the 328 

acquisition settings chosen above. 329 

 330 

3. Spectral response correction (optional):  331 

 332 

3.1) Spectral output correction can be performed to calibrate the spectral response of the 333 

system to a known standard, such as a NIST-traceable lamp or other NIST-traceable standard or 334 

instrument. This step is especially important if results are compared with other spectral imaging 335 

instruments, spectrometers, or between different laboratories. This process has been reported 336 

in detail previously21,23. 337 

 338 

3.1.1) Use a spectrometer calibrated to a NIST-traceable light source (such as LS-1-CAL-INT, 339 

Ocean Optics) or other NIST-traceable standard to acquire the spectroradiometric power of the 340 

illumination as measured at the sample stage. Perform a separate correction for each 341 

combination of light source setting, dichroic mirror, and objective. Use an integrating sphere 342 

coupled to the spectrometer to accurately measure wide-angle illumination from the 343 

microscope objective.  344 

 345 

3.1.2) Use an integration method, such as the trapezoidal rule, to integrate the 346 

spectroradiometric data over wavelengths illuminated. A 40 nm bandwidth for integration 347 

centered around the center wavelength is sufficient for most filters that have a nominal 348 

bandwidth of between 14–20 nm full-width at half-maximum (FWHM). The integrated value 349 

represents the intensity of the spectral illumination at each excitation wavelength band. 350 

 351 



3.1.3) Plot the integrated intensity of each wavelength band as a function of excitation center 352 

wavelength to allow visualization of the spectral illumination intensity profile. 353 

 354 

3.1.4) Determine the wavelength band with the lowest integrated intensity. 355 

 356 

3.1.5) Normalize the spectral illumination intensity profile by dividing the lowest integrated 357 

intensity by the integrated intensity of each wavelength band to generate a wavelength-358 

dependent correction factor. 359 

 360 

4. Sample preparation 361 

 362 

4.1) Prepare a “blank” sample (e.g., place a glass coverslip in the cell chamber and add 1 mL of 363 

buffer). This buffer has been described previously24. 364 

 365 

4.2) Prepare an unlabeled sample to determine any sample autofluorescence (e.g., place a glass 366 

coverslip containing unlabeled airway smooth muscle cells25,26 in the cell chamber and add 1 mL 367 

of buffer). 368 

 369 

4.3) Prepare a separate, single-labeled sample for each fluorescent label used in the experiment 370 

as follows: 371 

 372 

4.3.1) Add diluted mitochondrial label to buffer to achieve a 100 nM concentration. Add this 373 

buffer to the coverslip containing airway smooth muscle cells. Incubate for 20 min at 20–25 ˚C. 374 

Move the coverslip to the cell chamber and add 1 mL of buffer. Note that the optimal 375 

concentration of mitochondrial label will vary by factors such as manufacturer, associated color, 376 

and desired specificity. 377 

 378 

4.3.2) Move a coverslip containing airway smooth muscle cells transfected with the GCaMP 379 

probe27 to the cell chamber and add 1 mL of buffer. 380 

 381 

4.4) Prepare one or more experimental samples containing a mixture of the desired fluorescent 382 

labels. 383 

 384 

4.4.1) Add 1 mL of buffer (100 nM concentration of mitochondrial label) to a coverslip 385 

containing airway smooth muscle cells transfected with the GCaMP probe and incubate for 20 386 

min at 20–25 ˚C. Move the coverslip to the cell chamber and add 1 mL of buffer. 387 

 388 

5. Data acquisition and image analysis: 389 

 390 

5.1) Check that the proper dichroic beamsplitter (e.g., 495 nm dichroic filter cube), objective 391 

(e.g., 60x water objective), and camera (sCMOS camera) are selected. 392 

 393 

5.2) Load the sample on the stage. 394 

 395 



5.3) Double-click the box next to Exposure [ms] and type “100” to set the exposure time at 100 396 

ms. Note that the exposure time may need to be increased or decreased depending on the 397 

fluorescence intensity of the sample. 398 

 399 

5.4) Select 475 nm from the drop-down menu of the Micro-Manager main window for initial 400 

sample viewing. Note that 475 nm may not be the optimal wavelength for sample viewing or 401 

determining whether oversaturation will occur throughout the image stack. 402 

 403 

5.5) Click Live to view the sample. 404 

 405 

5.5.1) Click the automatic intensity viewing range button Auto next to the histogram on the 406 

bottom of the window to bring the minimum and maximum values into meaningful visual 407 

ranges. 408 

 409 

5.6) Use the microscope’s focus knobs to focus on the sample. It is often useful to find the edge 410 

of the sample to aid in focusing. The sample will be focused when the edge features in the 411 

image appear sharp. Note that it may be necessary to click the Auto button several times 412 

during focusing to aid in viewing the fluorescence image. Additionally, some users may find it 413 

easier to focus on the sample if the microscope is in transmission mode. 414 

 415 

5.6.1) If focusing in transmission mode, for safety, first ensure that the spectral light source is 416 

not transmitting light to the eyepieces before adjusting the light path for transmission imaging. 417 

Also note that there may be small deviations between the focus of the transmission and 418 

fluorescence images. When acceptable focus has been achieved, reconfigure the light path for 419 

spectral fluorescence imaging. 420 

 421 

5.7) Click the Multi-D Acq. button near the top left of the window to open the Multi-422 

Dimensional Acquisition tool (described and configured in section 2). 423 

 424 

5.8) Choose an appropriate spectral range for spectral acquisition (e.g., 360–485 nm for the 495 425 

nm dichroic filter) by clicking the Load… button in the upper right of the Multi-Dimensional 426 

Acquisition tool window and navigating to the excitation settings saved previously (in step 427 

2.1.4.10). See discussion for information regarding appropriate spectral ranges. 428 

 429 

5.9) Acquire a background/blank image that contains no fluorescence data to use for 430 

background and noise subtraction. This can be performed using a blank sample (step 4.1) or by 431 

navigating to a blank region of an experimental sample. As described in step 5.6, this is most 432 

easily achieved by finding the edge of the sample then positioning it so that the edge is 433 

centered within the field of view. 434 

 435 

5.9.1) Once the acquisition settings are confirmed and a background region is visible, click the 436 

Acquire! button to acquire a spectral image stack containing background and noise to use for 437 

subtraction later. It should be noted that samples are likely to have more intense fluorescence 438 

away from the edge of the sample. It may be advisable to move about the sample to find the 439 



“brightest” regions and perform several test image stacks to determine appropriate acquisition 440 

times and avoid overexposure. 441 

 442 

5.10) Take a single image stack on a region of the sample that appears to have intense 443 

fluorescence to ensure that no combination of wavelengths and that exposure times result in 444 

overexposure. 445 

 446 

5.11) Use ImageJ to confirm that no wavelengths contain overexposed pixels. 447 

 448 

5.11.1) In ImageJ, click File > Import > Image Sequence and navigate to the folder containing 449 

the spectral images taken in step 5.10. This will open a new window. Click the box next to 450 

Number of images and enter the number of wavelengths included in the spectral scan (e.g., 451 

26). Leave Starting image and Increment as “1”. Click the OK button to continue. 452 

 453 

5.11.2) Press M on the keyboard to utilize ImageJ’s measure function. Ensure that the number 454 

listed under Max is not the upper detection limit of the camera (e.g., 65,535). Repeat for each 455 

image in the spectral scan. Note that the detection limit of the camera depends on the camera 456 

itself. The upper limit is displayed on the top right portion of the histogram in the main window 457 

of MicroManager. Alternatively, the upper limit can be determined by opening an image in 458 

ImageJ and navigating to Image > Adjust > Brightness/Contrast. Click the Set button in the 459 

resulting pop-up window, enter an excessively large value (e.g., 999,999) in the blank next to 460 

Maximum displayed value, and click OK to continue. The maximum value displayed in the new 461 

histogram should be the upper detection limit of the camera. 462 

 463 

5.11.3) If any images contained the upper detection limit of the camera (e.g., 65,535), adjust 464 

the exposure time of the spectral scan to ensure that the maximum signal throughout the 465 

spectral range does not exceed the dynamic range of the camera. 466 

 467 

5.12) Acquire spectral image data from unlabeled samples to determine any autofluorescence. 468 

Acquire the scan for the unlabeled samples using an identical wavelength range and camera 469 

settings as the remainder of the experiment (e.g., 360–485 nm at 100 ms per wavelength). 470 

 471 

5.13) Acquire spectral image data from single-labeled samples to use as spectral controls to 472 

build the spectral library. Perform the scan for each label using an identical wavelength range, 473 

exposure time, and camera settings. Note that a longer acquisition time may be needed for 474 

some samples to allow accurate label spectrum detection with minimum noise contribution. 475 

 476 

5.14) Perform measurements on an experimental sample (e.g., human airway smooth muscle 477 

cells with GCaMP probe and mitochondrial label). 478 

 479 

5.14.1) Place a slide or coverslip containing the experimental sample on the microscope. 480 

 481 

5.14.2) Select a field of view with appropriately labeled cells of tissues. 482 

 483 



5.14.3) Acquire the spectral image data using the desired acquisition settings, as described 484 

above. 485 

 486 

6. Image analysis 487 

 488 

6.1) Correct images to a flat spectral response.  489 

 490 

6.1.1) Subtract the background spectrum obtained in section 5.9 and multiply by the correction 491 

coefficient determined in section 3.1.5. This can be done with a simple MATLAB script or ImageJ 492 

routine. A subtraction/correction MATLAB code (used in this example) is available on the 493 

University of South Alabama Bioimaging Resources website. 494 

 495 

6.1.1.1) Load the subtraction/correction code in MATLAB. 496 

 497 

6.1.1.2) In the EDITOR tab, click Run. This will open a new window containing a Bsq Correction 498 

button. Click the Bsq Correction button to open another window containing choices for working 499 

directory, background file, correction factor file, and uncorrected tiff folder. 500 

 501 

6.1.1.2.1) Use the Browse… button beside Working Directory to choose the file path where 502 

subsequent windows will open. Navigate to the folder containing the saved background 503 

spectrum (in .dat format). 504 

 505 

6.1.1.2.2) Use the Browse… button beside Background File (.dat) to open the directory chosen 506 

in step 6.1.1.2.1 and choose the desired background file (in .dat format). Click the Open button 507 

to continue. 508 

 509 

6.1.1.2.3) Use the Browse… button beside Correction Factor (.dat) to choose a correction 510 

factor. The directory for the correction factor defaults to the location of the parent MATLAB 511 

code. If necessary, navigate to the subfolder containing the correction factor file (in .dat 512 

format). Highlight the proper correction factor file and click the Open button to continue. 513 

 514 

6.1.1.2.4) Use the Browse… button beside Uncorrected Tiff Folder to open the directory chosen 515 

in step 6.1.1.2.1 and choose the folder for background subtraction and image correction (this is 516 

usually the Pos0 folder that immediately contains the raw spectral images). Click the Open 517 

button to continue. 518 

 519 

6.1.1.2.5) Click the Click for Spectral Correction button. After processing completes, a window 520 

will open with the message “Bsq Correction Complete”. Click the OK button to continue. The 521 

correction images are stored in a new folder named with the original raw spectral image folder 522 

and an additional “_Corrected” (e.g., Pos0_Corrected). 523 

 524 

6.2) Generate the spectral library. Several software packages can be used to extract spectral 525 

data from images, including ImageJ. For best results, normalize each endmember to the 526 

wavelength band of greatest intensity by determining which wavelength band has the most 527 



intense value and dividing the measurement at each wavelength band by that maximum value. 528 

It should also be noted that single-label controls generated within autofluorescent samples will 529 

need additional modifications28–32. See step 6.2.4 and discussion for details. 530 

 531 

6.2.1) In ImageJ, click File > Import > Image Sequence. This will open a new window. Navigate 532 

to the folder containing the corrected spectral images. Double-click any image file in the folder 533 

to open a new window. Click the box next to Number of images and enter the number of 534 

wavelengths included in the spectral scan (e.g., 26). Leave Starting image and Increment as “1”. 535 

Click the OK button to continue. 536 

 537 

6.2.2) In the ImageJ main window, click the Polygon selections icon, then use the mouse 538 

pointer by clicking on the image to create a polygon around a region containing fluorescence 539 

data. Note that there may be little to no fluorescence data in the initial wavelength. Navigate to 540 

another wavelength image and/or use the brightness/contrast tool (Image > Adjust > 541 

Brightness/Contrast > Auto) to better visualize regions containing fluorescence data of interest. 542 

 543 

6.2.3) With the polygon drawn, generate the Z-axis profile by clicking Image > Stacks > Plot Z-544 

axis Profile. This will open a new window. Click Save to save the spectral data as a .csv file. 545 

 546 

6.2.4) Perform a subtraction to ensure a proper spectral library with pure labels devoid of 547 

autofluorescence contamination. Use the following equation29 to isolate a pure spectrum from 548 

the mixture of a single-label and fluorescence: 549 

 550 

𝑺𝒑𝒖𝒓𝒆 = 𝑺𝒎𝒊𝒙𝒆𝒅 − (𝑎 ×  𝑺𝒂𝒖𝒕𝒐𝑭𝑳) + 𝑜𝑓𝑓𝑠𝑒𝑡                  (1) 551 

 552 

Where: Spure is the pure spectrum of the label, Smixed is the measured spectrum of the sample 553 

contaminated with autofluorescence, SautoFL is the measured autofluorescence spectrum, “a” is 554 

a scalar multiplier of the autofluorescence spectrum (between 0 and 1; e.g., 0.4), and “offset” is 555 

an offset (usually 0). Vary the “a” term until a near-zero value is achieved for the apparent 556 

contribution of autofluorescence. Additional information can be found in several publications28–557 
32. 558 

 559 

6.3) Unmix the spectral image data. The unmixing step will generate an abundance image for 560 

each fluorescent label, where abundance is the amount of relative fluorescence signal in the 561 

image from the respective label. Several unmixing algorithms are available for use with 562 

ImageJ33–35. Additionally, a spectral unmixing MATLAB code (used in this example) is available 563 

on the University of South Alabama Bioimaging Resources website. A more comprehensive 564 

overview of spectral unmixing is available36. 565 

 566 

6.3.1) Load the spectral unmixing code in MATLAB. 567 

 568 

6.3.2) Edit the Wavelength.mat and Library.mat files to correspond to the experimental 569 

conditions (e.g., “Wavelength” as 360–485 in increments of five).  570 

 571 



NOTE: The corresponding values for those wavelengths should be loaded into “Library” for each 572 

fluorescent label (and autofluorescence). Endmember_Name should list the labels in the same 573 

order as the column values of “Library”. Note that the Library.mat file should contain both 574 

“Library” and “Endmember_Name” variables. 575 

 576 

6.3.3) In the EDITOR tab, click Run. This will open a new window allowing the user to choose a 577 

directory. Navigate to the folder containing the spectral images to be unmixed. Once selected, 578 

this will open a new window. 579 

 580 

6.3.4) In the resultant blanks, enter the image name (e.g., HASMC with GCaMP and Mito FOV1), 581 

number of wavelength bands (e.g., 26), number of timepoints (e.g., 1) and whether a FRET 582 

measurement is desired (e.g., n) in their respective blanks. If “n” is selected for FRET, leave both 583 

End-Member blanks empty. Press OK to continue, which will open a new window. 584 

 585 

6.3.5) Naviagate to the folder containing the Wavelength.mat file. Once selected, click Open to 586 

continue, which will open a new window. 587 

 588 

6.3.6) Navigate to the folder containing the Library.mat file. Once selected, click Open to 589 

continue, which will save the unmixed images in a new “Unmixed” folder inside the directory 590 

containing the spectral images. 591 

 592 

6.4 Inspect the unmixed spectral images for quality. 593 

 594 

6.4.1) Open each unmixed image to visually inspect the distribution of pure components. 595 

 596 

6.4.1.1) Compare the magnitude of the error image to those of the unmixed images (similar to 597 

step 5.11, this can be done through ImageJ’s measure function). If the magnitude of the error 598 

image is similar in magnitude to the unmixed abundance images, it is likely that there are 599 

signals in the spectral image data that are not accurately accounted for by the spectral library 600 

and the linear spectral unmixing process. 601 

 602 

6.4.1.2) Compare the error image to the unmixed images to see if there are unidentified 603 

residual structures. 604 

 605 

REPRESENTATIVE RESULTS: 606 

 607 

Several important steps from this protocol are necessary to ensure the collection of data that is 608 

both accurate and devoid of imaging and spectral artifacts. Skipping these steps may result in 609 

data that appear significant but cannot be verified or reproduced with any other spectral 610 

imaging system, thereby effectively nullifying any conclusions made with said data. Chief 611 

among these important steps is proper spectral output correction (section 3). The correction 612 

factor compensates for wavelength-dependent variations in the spectral output of the tunable 613 

excitation system. This is accomplished by scaling wavelengths with high power excitation such 614 

that the optical illumination power is comparable to wavelengths with a low power excitation, 615 



achieving a flat spectral excitation profile. An example of an inappropriate correction factor is 616 

one that contains very low values (e.g., <0.001) at one or more wavelengths, indicating that the 617 

intensity values measured at those wavelengths must be greatly attenuated to achieve a flat 618 

spectral response.  619 

 620 

Calibration of the system to a NIST-traceable standard ensures that data collected with the 621 

excitation-scanning spectral imaging system is comparable to other systems also calibrated to 622 

NIST-traceable standards. Therefore, it is imperative to ensure that any correction factor 623 

adjusts the collected data appropriately. Accuracy of a correction factor can be verified with the 624 

use of a fluorescence standard, such as NIST-traceable fluorescein. Figure 1 illustrates an 625 

appropriate and inappropriate correction factor, visualized through graphical and image data. 626 

In this case, the spectral output at 340 nm was virtually nonexistent compared to the rest of the 627 

spectral range, resulting in a near-zero (<0.001) value for virtually every wavelength. Applied to 628 

the image stack, this results in near-zero values through most of the image stack for most 629 

pixels.  630 

 631 

As stated in section 5, the excitation range, selected fluorophores, and acquisition settings may 632 

create the potential that one or many excitation wavelength image bands contain 633 

oversaturated pixels. Figure 2 illustrates an example in which the exposure time was set too 634 

long for several of the excitation wavelengths, causing the subsequent images to contain 635 

oversaturated pixels. This is important to note because, as the figure shows, both the individual 636 

images and the false-colored images may visually appear to be within acceptable intensity 637 

ranges.  638 

 639 

Appropriate selection of a background region for subtraction is also important for data 640 

comparison among systems, as it removes elements of camera noise or stray light prior to NIST-641 

traceable spectral correction (Figure 3). It is often helpful for subsequent image processing and 642 

data analysis steps to generate an RGB false-colored image of the spectral image stack in order 643 

to visualize spectral features within the image. Figure 4 shows an RGB false-colored image 644 

generated by merging three selected wavelength bands (370 nm = blue, 420 nm = green, 470 645 

nm = red). 646 

 647 

Spectral unmixing requires knowledge of the spectral profile of each individual fluorescence 648 

source. In the case of excitation-scanning hyperspectral imaging, this is done by acquiring 649 

spectral image stacks for each fluorophore (and autofluorescence). Figure 5 is included as an 650 

example for choosing regions from single-label controls to generate a spectral library. It should 651 

be noted that each measurement has been normalized to its peak wavelength.  652 

 653 

When performed correctly, the spectral unmixing process allows separation of a spectral image 654 

stack into respective contributions from each fluorescence label. Figure 6 shows an example 655 

unmixed spectral image set, with individual images for each of the following signals: airway 656 

smooth muscle cell autofluorescence, a GCaMP probe, and a mitochondrial label. The error 657 

associated with spectral unmixing is also shown and can be examined to compare intensity 658 

levels of the error to those of the unmixed signals. Calculation and interpretation of this error 659 



has been discussed previously37. As shown in Figure 6, there is high error associated with the 660 

nuclear and perinuclear regions of the cells, indicating that the measured spectra of those 661 

regions are not well accounted for by the spectra in the spectral library. One potential source of 662 

error may be that the single-label controls for GCaMP and the mitochondrial label were 663 

prepared using airway smooth muscle cells, which have a high native autofluorescence. Hence, 664 

the GCaMP and the mitochondrial label may not represent pure endmember spectra. In 665 

addition, the autofluorescence signal may influence the library spectra for the two other labels 666 

in a way for which was not properly accounted, resulting in a less accurate fitting than if the 667 

labels had been acquired using a cell line with little to no autofluorescence. Additionally, 668 

examples are included for when too few or too many components of a spectral library are 669 

available, resulting in underfitting and overfitting of the spectral image data, respectively 670 

(Figure 6, Figure 7, Figure 8, Figure 9, and Table 1).  671 

 672 

As noted in section 6.2 and specifically step 6.2.4, “pure” spectra collected from labeled cells 673 

that are also autofluorescent will likely contaminate the spectral profile for the pure 674 

component. As such, care should be taken to separate the pure spectra of the labels of interest 675 

from their autofluorescent hosts. Figure 10 shows the difference of unmixing with “pure” 676 

spectra contaminated with autofluorescence (mixed) versus pure spectra calculated by the 677 

method described in step 6.2.4. The difference occurs mainly in unmixing the autofluorescence 678 

signal. Without proper signal separation (e.g., subtraction of autofluorescence contamination 679 

from the GCaMP spectrum), the autofluorescence and GCaMP library components compete for 680 

the same spectral data in each pixel, resulting in characteristic holes or dark spots in the 681 

autofluorescence image. 682 

 683 

FIGURE & TABLE LEGENDS: 684 

 685 

Figure 1: Example applications of inappropriate and appropriate correction factors used to 686 

correct images to a flat spectral response. (A) Plotted inappropriate and appropriate correction 687 

factors. (B) An RGB image generated with use of the inappropriate correction factor in (A). (C) 688 

An RGB image generated with the same field of view as (B), except with the use of an 689 

appropriate correction factor. 690 

 691 

Figure 2: Examples that illustrate the importance of appropriate acquisition settings. (A,B) 692 

RGB images generated by an appropriate acquisition time (A, 100 ms) vs. the same field of view 693 

with a saturating acquisition time (B, 500 ms). It should be noted that the RGB images appear 694 

identical when false-colored. (C) The region of interest selected to survey intensity values from 695 

the most intense regions of (A) and (B). (D) Plotted intensity values per wavelength from the 696 

100 ms exposure time image (A, black line) and 500 ms exposure time (B, red line). It should be 697 

noted that pixel intensities for the 500 ms exposure time have reached the limit of the dynamic 698 

range of the detector (65,535 AU) at 370 nm and do not decrease until 525 nm, resulting in 699 

spectral artifact. 700 

 701 

Figure 3: Selection of a region of interest for background subtraction. (A) A raw, wavelength-702 

summed intensity image. (B) Regions of the image selected to determine the pixel-averaged 703 



background spectrum for background subtraction shown in red. (C) The background-subtracted, 704 

corrected, and summed intensity image. (D) An RGB coloring of the corrected image (C). The 705 

process of generating an RGB false-colored image is shown in Figure 4. 706 

 707 

Figure 4: Process of generating an RGB false-colored image. (A–C) Three wavelength bands 708 

spaced evenly throughout the spectral acquisition range were selected for false-coloring (blue = 709 

370 nm, green = 420 nm, red = 470 nm). (D) The summed intensity image generated by adding 710 

pixel intensities from all wavelength bands in the image cube. (E–G) The images in panels (A–C) 711 

with their respective false-color look-up tables applied. (H) The resultant merged image of (E–712 

G). 713 

 714 

Figure 5: Region selection of single-label controls for spectral library generation. (A) RGB 715 

false-colored image of airway smooth muscle (ASM) cell autofluorescence. (B) Shown in red, 716 

regions of (A) chosen for the autofluorescence component of the spectral library. (C) RGB false-717 

colored ASM cells labeled with the mitochondrial label. (D) Shown in red, regions of (C) chosen 718 

for the mitochondiral label component of the spectral library. Due to the autofluorescence of 719 

the ASM cells localized near the nucleus, small regions were selected far from the nuclei to 720 

identify the mitochondrial label spectrum. (E) RGB false-colored ASM cells transfected with the 721 

GCaMP probe. (F) Regions of (E) selected for the GCaMP component of the spectral library are 722 

shown in red. Similar to (D), regions away from the nuclei were selected. (G) The spectral library 723 

obtained from A–F, normalized to a value of unity at the wavelength with the strongest signal. 724 

 725 

Figure 6: Example of unmixed image data in which unmixed relative signal contributions from 726 

each library component can be visualized. (A–D) The unmixed abundance of GCaMP, 727 

mitochondrial label, autofluorescence, and error term. (E–G) The images in panels (A–C) with 728 

their respective false-color look-up tables applied. (H) The composite, merged, false-colored 729 

image. 730 

 731 

Figure 7: Unmixed relative signal contributions, including mean intensity and percent of total 732 

fluorescence, from a properly defined spectral library. (A–D) The unmixed abundance for 733 

autofluorescence, GCaMP, mitochondrial label, and error term. It should be noted that the 734 

error term comprises less than 10% of the total fluorescence signal measured. 735 

 736 

Figure 8: Unmixed relative signal contributions, including mean intensity and percent of total 737 

fluorescence, from a spectral library missing a component known to be included in the 738 

sample (i.e., an underdefined spectral library). (A–C) The unmixed abundance of 739 

autofluorescence, mitochondrial label, and error term. Note that the omission of GCaMP from 740 

the spectral library has increased the calculated relative signal contributions from the library 741 

components as well as the error term, when compared to Figure 7. 742 

 743 

Figure 9: Unmixed relative signal contributions, including mean intensity and percent of total 744 

fluorescence, from a spectral library containing an additional component known to be 745 

missing in the sample (i.e., an overdefined spectral library). (A–E) The unmixed abundance of 746 

autofluorescence, GCaMP, mitochondrial label, nuclear label, and error term. Note that the 747 



addition of a nuclear label to the spectral library has decreased the calculated relative signal 748 

contributions from autofluorescence, when compared to Figure 7. Furthermore, the error term 749 

is decreased below the percent error specified by the properly defined spectral library. This is 750 

because an overdefined library will almost always allow a better fit to the experimental data 751 

than a properly defined library, even though abundance signals for components known to be 752 

absent from the sample are (in reality) artifacts of overdefining the spectral library. 753 

 754 

Figure 10: Comparison of unmixed images when using a library before and after proper 755 

autofluorescence contamination signal subtraction. (A) The original “pure” spectra derived 756 

from the single-label controls in highly autofluorescent airway smooth muscle cells before the 757 

scaled subtraction detailed in step 6.2.4. (B–D) The unmixed autofluorescence, GCaMP, and 758 

nuclear label images generated using (A) as the library. (E) The corrected pure spectra derived 759 

from single-label controls in highly autofluorescent airway smooth muscle cells after scaled 760 

subtraction. (F–H) The unmixed autofluorescence, GCaMP, and nuclear label images generated 761 

using (E) as the library. 762 

 763 

Table 1: A table comparing the average, standard deviation, and maximum unmixed abundance 764 

intensity values per unmixed abundance image from a proper spectral library and from 765 

underdefined or overdefined spectral libraries, as well as the percent of total fluorescence per 766 

unmixed abundance image (the minimum unmixed abundance intensity for each image was 767 

always zero). Data taken from Figure 7, Figure 8, and Figure 9. 768 

 769 

DISCUSSION: 770 

 771 

The optimal use of an excitation-scanning hyperspectral imaging set-up begins with 772 

construction of the light path. In particular, choice of light source, filters (tunable and dichroic), 773 

filter switching method, and camera determine the available spectral range, possible scan 774 

speed, detector sensitivity, and spatial sampling. Mercury arc lamps offer many excitation 775 

wavelength peaks but do not provide a flat spectral output and will require significant signal 776 

reduction at the output peaks to correct the spectral image data back to a NIST-traceable 777 

response38. Alternative light sources, such as Xe arc lamps and white light supercontinuum 778 

lasers, may provide a more uniform spectral output that is better suited for excitation-scanning 779 

hyperspectral imaging38–40. Choice of light source, tunable filters, and dichroic filters determine 780 

the available spectral range. This range should be chosen with careful consideration for the 781 

desired spectral information of the experimental sample.  782 

 783 

Additionally, consideration should be given to the switching mechanism used for the tunable 784 

filters, as well as various camera factors such as quantum efficiency, pixel size, and available 785 

frame rates, as these factors will affect potential sampling rates41–43. However, all other factors 786 

being constant, utilization of the excitation-scanning approach should provide increased 787 

sensitivity and the ability for faster imaging, compared to most emission-scanning spectral 788 

imaging approaches21. 789 

 790 



As noted in the introduction, hyperspectral imaging here refers to the contiguous and spectrally 791 

overlapping nature of the acquired data. As such, the capabilities of the system need to be able 792 

to collect data using spacing of excitation center wavelengths less than half the distance of the 793 

FWHM of the filters. As reported previously, a carefully chosen array of thin-film tubable filters 794 

allows data acquisition with center wavelengths spaced 5 nm apart, a distance sufficient to 795 

oversample the excitation spectrum given filters with FWHM of between 14–20 nm. Such a 796 

spacing gives slight redundancy in spectral data collection with likely increases the accuracy of 797 

the unmixing process. Consideration of both spectral ranges and necessary minimum number 798 

of wavelength channels for accurate unmixing have been discussed previously44–46. To this end, 799 

given the bandwidth of these filters, the excitation range should be selected to end at a 800 

wavelength that is somewhat lower (5–10 nm lower) than the cut-off wavelength of the 801 

dichroic beamsplitter. This will ensure that the entire bandwidth of the excitation illumination is 802 

below the cutoff wavelength of the dichroic beamsplitter (e.g., 360–485 nm for the 495 dichroic 803 

filter) to avoid excitation-emission cross-talk. 804 

 805 

Software to independently control each component of the hardware to achieve high-speed 806 

spectral imaging scans is required. The software should be able to operate the shutter, select 807 

excitation wavelengths, and acquire images at sufficiently high speeds to meet experimental 808 

conditions (exact sample rate requirements will vary experiment, but an example goal might be 809 

to acquire four complete spectral image stacks per minute). More complex experiments may 810 

make use of multiple dichroic mirrors, objectives, or XYZ locations. There are a number of 811 

software packages available for data acquisition47,48. Micro-Manager is a free open-source 812 

software for microscope automation that offers a variety of customization options. 813 

Furthermore, Micro-Manager includes a scripting panel for additional customization not 814 

available within the main user interface. For example, it is possible to use a custom script to 815 

reduce the 250 ms delay of the tunable filter switcher to 10 ms at all excitation wavelengths 816 

except the wavelength transitions in which the filter wheel rotates to a new tunable filter, 817 

reducing the effective imaging time by 240 ms per wavelength for most wavelengths. This 818 

customization has allowed acquisition of up to 30 wavelengths in under 4 s. Finally, Micro-819 

Manager can be operated alongside other environments, such as MATLAB, to further customize 820 

microscope device control. 821 

 822 

Determining the proper spectral excitation range, acquisition time, and initial wavelength for 823 

sample viewing and subsequent data acquisition is very important. However, incorrect 824 

operation of individual components of the system may require further troubleshooting. Each 825 

component of the optical path contributes to the image data acquired. Hence, it is important to 826 

verify the spectral response and optical transmission of optical components within the light 827 

path, especially if trying to optimize overall system response. Light sources often have variable 828 

intensity settings and may have reduction in power over the lifetime of the bulb40. If a sample 829 

appears dim, the cause may be reduced output from the light source. The autoshutter function 830 

in Micro-Manager, in our experience, does not operate 100% of the time. Lack of signal may 831 

indicate a closed shutter. The initial excitation wavelength saved within Micro-Manager’s 832 

configuration file may default to a wavelength with little or no spectral output, such as the 340 833 

nm example shown in Figure 1.  834 



 835 

Additionally, it is not uncommon to mistakenly choose an excitation wavelength that is above 836 

the cutoff wavelength of the long-pass dichroic beamsplitter, resulting in additional cross-talk 837 

and/or excitation light being shunted directly to the camera which may potentially damage the 838 

camera sensor. Similarly, adjusting the light path for transmission imaging may result in loss of 839 

signal to the eyepieces, depending on the configuration of the microscope. Furthermore, as 840 

indicated in Figure 2, choice of initial excitation wavelength and exposure time for sample 841 

viewing may appear appropriate but actually result in oversaturated pixels at other excitation 842 

wavelengths. This fact will not be apparent unless pixel saturation is checked for each image, so 843 

it is often prudent to perform a test image stack on an area of the sample that appears to 844 

contain the most intense fluorescence.  845 

 846 

It is also worth noting that variable intensities may be present in images chosen for background 847 

regions. Care should be taken to ensure that these regions do not actually contain relevant 848 

image data, as subsequent data correction steps will then subtract this signal from the image 849 

data acquired at other regions in the sample. It is sometimes necessary to use the transmission 850 

settings and/or drastically increase the exposure time to check that the region selected for 851 

measuring sample background does indeed contain no sample. Similarly, unmixed images may 852 

present with dark spots or holes in the autofluorescence image. This may be due to an 853 

improper library caused by autofluorescence “contamination” of the “pure” spectral signals 854 

from single-labeled cells. This is because any “pure” spectral signal collected from a sample 855 

containing autofluorescence will invariably contain some of the autofluorescence spectra itself, 856 

even if in trace amounts. Care should be taken to subtract out autofluorescence signals from 857 

the single-labeled controls to ensure a proper spectral library, as described on several occasions 858 

by Mansfield et al.28–32 859 

 860 

Though not demonstrated in this article, the excitation-scanning spectral imaging system can 861 

also be used for time-lapse imaging and imaging over multiple XY locations (or a large field of 862 

view due to image stitching) in multiple focal planes. If these options are desired for a single 863 

experiment, careful thought should be given to the importance of acquisition order and 864 

potential effects of photobleaching. It is also worth noting that if the actual time taken exceeds 865 

the estimated time (e.g., an image stack takes 11 s to acquire rather than the estimated 10 s), 866 

Micro-Manager will continue to acquire the selected number of timepoints and/or positions. 867 

This miscalculation can compound with multiple timepoints and alter calculated temporal 868 

sampling, potentially skewing any conclusions made from the data. 869 

 870 

This example demonstrates the ability to separate three sources of fluorescence within a 145 871 

nm excitation scanning range. Previous experiments using this system have been able to 872 

separate up to five sources of fluorescence within the same range. The time required for this 873 

image acquisition is less than 1 min, which is significantly faster than most emission-scanning 874 

spectral imaging systems. Improvements in the light path, such as higher speed excitation 875 

wavelength tuning, may further advance this imaging technology to speeds that are sufficient 876 

for video-rate spectral imaging. 877 

 878 
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Proper Fitting Underfitting Overfitting

Autofluorescence 187 299 164

GCaMP 139 - 140

Mitochondrial Label 246 318 248

Nuclear Label - - 26

RMS Error 53 126 43

Proper Fitting Underfitting Overfitting

Autofluorescence 362 442 315

GCaMP 168 168

Mitochondrial Label 344 388 345

Nuclear Label - - 93

RMS Error 62 126 44

Proper Fitting Underfitting Overfitting

Autofluorescence 6738 7409 6738

GCaMP 1336 - 1336

Mitochondrial Label 5098 5194 5098

Nuclear Label - - 1257

RMS Error 1050 1286 910

Proper Fitting Underfitting Overfitting

Autofluorescence 30% 40% 26%

GCaMP 22% 43% 23%

Mitochondrial Label 39% - 40%

Nuclear Label - - 4%

RMS Error 8% 17% 7%

Mean Intensity (AU)

Standard Deviation (AU)

Maximum Intensity (AU)

% of Total Fluorescence
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Name of Material/ Equipment Company

Airway Smooth Muscle Cells National Disease Research Interchange (NDRI)

Automated Shutter Thorlabs Inc.

Automated Stage Prior Scientific

Automated Stage Controller (XY) Prior Scientific
Buffer Made in-house

Cell Chamber ThermoFisher Scientific

Excitation Filters Semrock Inc.

Semrock Inc.

Semrock Inc.

Semrock Inc.

Semrock Inc.

Fluorescence Filter Cube Dichroic Beamsplitter Semrock Inc.

Fluorescence Filter Cube Longpass Filter Semrock Inc.

GCaMP Probe Addgene

Integrating Sphere Ocean Optics

Inverted Fluorescence Microscope Nikon Instruments

Mitotracker Green FM ThermoFisher Scientific

NIST-Traceable Calibration Lamp Ocean Optics

NIST-Traceable Fluorescein ThermoFisher Scientific

NucBlue ThermoFisher Scientific

Objective (10X) Nikon Instruments

Objective (20X) Nikon Instruments

Objective (60X) Nikon Instruments

sCMOS Camera Photometrics

Spectrometer Ocean Optics

Tunable Filter Changer Sutter Instrument

Xenon Arc Lamp Sunoptic Technologies
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Scanning Paper.xls
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Catalog Number

Isolated from human lung tissues obtained from NDRI

SHB1

H177P1T4

Proscan III (H31XYZE-US)
Made in-house

Attofluor Cell Chamber, A7816

TBP01-378/16

TBP01-402/16

TBP01-449/15

TBP01-501/15

TBP01-561/14

FF495-Di03

FF01 496/LP-25

G-CaMP3; Plasmid #22692

FOIS-1

TE2000

M7514

LS-1-CAL-INT

F36915

R37605

Plan Apo λ 10X/0.45 ∞/0.17 MRD00105

Plan Apo λ 20X/0.75 ∞/0.17 MRD00205

Plan Apo VC 60X/1.2 WI ∞/0.15-0.18 WD 0.27

Prime 95B (Rev A8-062802018)

QE65000

Lambda VF-5

Titan 300HP Lightsource



Comments/Description

Highly autofluorescent, calcium sensitive cells

Remote-controllable shutter to minimize photobleaching

Remote-controllable stage for automated multiple field of view or stitched image collection.

For interfacing automated stage with computer and joystick
145 mM NaCl, 4 mM KCl, 20 mM HEPES, 10 mM D-glucose, 1 mM MgCl2, and 1mM CaCl2, at pH 7.3

Coverslip holder composed of surgical stainless steel and a rubber O-ring to seal in media and prevent sample and/or objective contamination

Center wavelength range (340-378 nm), Bandwidth (Minimum 16 nm, nominal FWHM 20 nm), Refractive index (1.88)

Center wavelength range (360-400 nm), Bandwidth (Minimum 16 nm, nominal FWHM 20 nm), Refractive index (1.8)

Center wavelength range (400-448.8 nm), Bandwidth (Minimum 15 nm, nominal FWHM 20 nm), Refractive index (1.8)

Center wavelength range (448.8-501.5 nm), Bandwidth (Minimum 15 nm, nominal FWHM 20 nm), Refractive index (1.84)

Center wavelength range (501.5-561 nm), Bandwidth (Minimum 14 nm, nominal FWHM 20 nm), Refractive index (1.83)

Separates excitation and emission light at 495 nm (>98% reflection between 350-488 nm, >93% transmission between 502-950 nm), Filter effective index (1.78)

Allows passage of light longer than 496 nm ( >93% average transmission between 503.2-1100 nm), Refractive index (1.86)

A single-wavelength GCaMP2-based genetically encoded calcium indicator

Used for accurate measurement of wide-angle illumination

Inverted microscopes allow direct excitation of sample without the need to penetrate layers of media and/or tissue.

Labels mitochondria

A lamp with a known spectrum for use as a standard

For verifying appropriate spectral response of the system

Labels cell nuclei

Useful for large fields of view

Most often used for tissue samples

Most often used for cell samples

For acquiring high-sensitivity digital images

Used to measure spectral output of excitation-scanning spectral system

Motorized unit for automated excitation filter tuning/switching

Light source with relatively uniform spectral output



Coverslip holder composed of surgical stainless steel and a rubber O-ring to seal in media and prevent sample and/or objective contamination

Separates excitation and emission light at 495 nm (>98% reflection between 350-488 nm, >93% transmission between 502-950 nm), Filter effective index (1.78)
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summaries, extracts, Derivative Works or Collective Works and
(c) to license others to do any or all of the above.  The
foregoing rights may be exercised in all media and formats,
whether now known or hereafter devised, and include the
right to make such modifications as are technically necessary
to exercise the rights in other media and formats.  If the “Open
Access” box has been checked in Item 1 above, JoVE and the
Author hereby grant to the public all such rights in the Article
as provided in, but subject to all limitations and requirements
set forth in, the CRC License.
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ARTICLE AND VIDEO LICENSE AGREEMENT 

4. Retention of Rights in Article.  Notwithstanding the
exclusive license granted to JoVE in Section 3 above, the
Author shall, with respect to the Article, retain the non-
exclusive right to use all or part of the Article for the non-
commercial purpose of giving lectures, presentations or
teaching classes, and to post a copy of the Article on the
Institution’s website or the Author’s personal website, in each
case provided that a link to the Article on the JoVE website is
provided and notice of JoVE’s copyright in the Article is
included.  All non-copyright intellectual property rights in and
to the Article, such as patent rights, shall remain with the
Author.

5. Grant of Rights in Video – Standard Access.  This Section 5
applies if the “Standard Access” box has been checked in Item
1 above or if no box has been checked in Item 1 above.  In
consideration of JoVE agreeing to produce, display or
otherwise assist with the Video, the Author hereby
acknowledges and agrees that, Subject to Section 7 below,
JoVE is and shall be the sole and exclusive owner of all rights of
any nature, including, without limitation, all copyrights, in and
to the Video.  To the extent that, by law, the Author is
deemed, now or at any time in the future, to have any rights
of any nature in or to the Video, the Author hereby disclaims
all such rights and transfers all such rights to JoVE. 

6. Grant of Rights in Video – Open Access.  This Section 6
applies only if the “Open Access” box has been checked in
Item 1 above.  In consideration of JoVE agreeing to produce,
display or otherwise assist with the Video, the Author hereby
grants to JoVE, subject to Section 7 below, the exclusive,
royalty-free, perpetual (for the full term of copyright in the
Article, including any extensions thereto) license (a) to publish,
reproduce, distribute, display and store the Video in all forms,
formats and media whether now known or hereafter
developed (including without limitation in print, digital and
electronic form) throughout the world, (b) to translate the
Video into other languages, create adaptations, summaries or
extracts of the Video or other Derivative Works or Collective
Works based on all or any portion of the Video and exercise all
of the rights set forth in (a) above in such translations,
adaptations, summaries, extracts, Derivative Works or
Collective Works and (c) to license others to do any or all of
the above.  The foregoing rights may be exercised in all media
and formats, whether now known or hereafter devised, and
include the right to make such modifications as are technically
necessary to exercise the rights in other media and formats.
For any Video to which this Section 6 is applicable, JoVE and 
the Author hereby grant to the public all such rights in the
Video as provided in, but subject to all limitations and
requirements set forth in, the CRC License.

7. Government Employees.  If the Author is a United States
government employee and the Article was prepared in the
course of his or her duties as a United States government
employee, as indicated in Item 2 above, and any of the
licenses or grants granted by the Author hereunder exceed the
scope of the 17 U.S.C. 403, then the rights granted hereunder
shall be limited to the maximum rights permitted under such

statute.  In such case, all provisions contained herein that are 
not in conflict with such statute shall remain in full force and 
effect, and all provisions contained herein that do so conflict 
shall be deemed to be amended so as to provide to JoVE the 
maximum rights permissible within such statute. 

8. Likeness, Privacy, Personality.  The Author hereby grants
JoVE the right to use the Author’s name, voice, likeness,
picture, photograph, image, biography and performance in any
way, commercial or otherwise, in connection with the
Materials and the sale, promotion and distribution thereof.
The Author hereby waives any and all rights he or she may
have, relating to his or her appearance in the Video or
otherwise relating to the Materials, under all applicable
privacy, likeness, personality or similar laws.

9. Author Warranties.  The Author represents and warrants
that the Article is original, that it has not been published, that
the copyright interest is owned by the Author (or, if more than
one author is listed at the beginning of this Agreement, by
such authors collectively) and has not been assigned, licensed,
or otherwise transferred to any other party. The Author
represents and warrants that the author(s) listed at the top of
this Agreement are the only authors of the Materials.  If more
than one author is listed at the top of this Agreement and if
any such author has not entered into a separate Article and
Video License Agreement with JoVE relating to the Materials,
the Author represents and warrants that the Author has been
authorized by each of the other such authors to execute this
Agreement on his or her behalf and to bind him or her with
respect to the terms of this Agreement as if each of them had
been a party hereto as an Author. The Author warrants that
the use, reproduction, distribution, public or private
performance or display, and/or modification of all or any
portion of the Materials does not and will not violate, infringe
and/or misappropriate the patent, trademark, intellectual
property or other rights of any third party.  The Author
represents and warrants that it has and will continue to
comply with all government, institutional and other
regulations, including, without limitation all institutional,
laboratory, hospital, ethical, human and animal treatment,
privacy, and all other rules, regulations, laws, procedures or
guidelines, applicable to the Materials, and that all research
involving human and animal subjects has been approved by
the Author's relevant institutional review board.

10. JoVE Discretion.  If the Author requests the assistance of
JoVE in producing the Video in the Author’s facility, the Author
shall ensure that the presence of JoVE employees, agents or
independent contractors is in accordance with the relevant
regulations of the Author's institution.  If more than one
author is listed at the beginning of this Agreement, JoVE may, 
in its sole discretion, elect not take any action with respect to
the Article until such time as it has received complete,
executed Article and Video License Agreements from each
such author.  JoVE reserves the right, in its absolute and sole
discretion and without giving any reason therefore, to accept
or decline any work submitted to JoVE.  JoVE and its
employees, agents and independent contractors shall have
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ARTICLE AND VIDEO LICENSE AGREEMENT 

full, unfettered access to the facilities of the Author or of the 
Author’s institution as necessary to make the Video, whether 
actually published or not.  JoVE has sole discretion as to the 
method of making and publishing the Materials, including, 
without limitation, to all decisions regarding editing, lighting, 
filming, timing of publication, if any, length, quality, content 
and the like. 
 
11.  Indemnification.  The Author agrees to indemnify JoVE 
and/or its successors and assigns from and against any and all 
claims, costs, and expenses, including attorney’s fees, arising 
out of any breach of any warranty or other representations 
contained herein.  The Author further agrees to indemnify and 
hold harmless JoVE from and against any and all claims, costs, 
and expenses, including attorney’s fees, resulting from the 
breach by the Author of any representation or warranty 
contained herein or from allegations or instances of violation 
of intellectual property rights, damage to the Author’s or the 
Author’s institution’s facilities, fraud, libel, defamation, 
research, equipment, experiments, property damage, personal 
injury, violations of institutional, laboratory, hospital, ethical, 
human and animal treatment, privacy or other rules, 
regulations, laws, procedures or guidelines, liabilities and 
other losses or damages related in any way to the submission 
of work to JoVE, making of videos by JoVE, or publication in 
JoVE or elsewhere by JoVE.  The Author shall be responsible 
for, and shall hold JoVE harmless from, damages caused by 
lack of sterilization, lack of cleanliness or by contamination 
due to the making of a video by JoVE its employees, agents or 
independent contractors.  All sterilization, cleanliness or 
decontamination procedures shall be solely the responsibility 
of the Author and shall be undertaken at the Author’s 

expense.  All indemnifications provided herein shall include 
JoVE’s attorney’s fees and costs related to said losses or 
damages.  Such indemnification and holding harmless shall 
include such losses or damages incurred by, or in connection 
with, acts or omissions of JoVE, its employees, agents or 
independent contractors. 
 
12.  Fees.  To cover the cost incurred for publication, JoVE 
must receive payment before production and publication the 
Materials. Payment is due in 21 days of invoice. Should the 
Materials not be published due to an editorial or production 
decision, these funds will be returned to the Author. 
Withdrawal by the Author of any submitted Materials after 
final peer review approval will result in a US$1,200 fee to 
cover pre-production expenses incurred by JoVE.  If payment is 
not received by the completion of filming, production and 
publication of the Materials will be suspended until payment is 
received. 
 
13.  Transfer, Governing Law.  This Agreement may be 
assigned by JoVE and shall inure to the benefits of any of 
JoVE’s successors and assignees.  This Agreement shall be 
governed and construed by the internal laws of the 
Commonwealth of Massachusetts without giving effect to any 
conflict of law provision thereunder.  This Agreement may be 
executed in counterparts, each of which shall be deemed an 
original, but all of which together shall be deemed to me one 
and the same agreement.  A signed copy of this Agreement 
delivered by facsimile, e-mail or other means of electronic 
transmission shall be deemed to have the same legal effect as 
delivery of an original signed copy of this Agreement.   
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Manager of Review 
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Dear Dr. Nguyen, 

 

We would like to thank you and the reviewers for your comments and questions concerning our 

manuscript “An excitation-scanning hyperspectral imaging microscopy method to efficiently 

discriminate fluorescence signals.” The comments received from the reviewers helped us clarify 

aspects of the manuscript, as well as revise the structure for a more consistent style. Please find 

below our responses to the comments and suggestions put forth by you and the reviewers. As 

indicated in the “revisions required” email, we have used the “track changes” feature to draw 

attention to our edits. Should you have any questions or additional formatting concerns regarding 

the manuscript, please contact me at your convenience. 

 

Sincerely, 

 

Silas J. Leavesley, Ph.D. 

Professor 

Department of Chemical and Biomolecular Engineering 

Department of Pharmacology 

Center for Lung Biology 

University of South Alabama 

150 Jaguar Drive, SH4129 

Mobile, AL 36688 

ph: (251)-460-6160 

fax: (251)-461-1485 

web: http://www.southalabama.edu/centers/bioimaging/ 

Rebuttal Letter Click here to access/download;Rebuttal Letter;Response to
Editor.pdf

https://www.editorialmanager.com/jove/download.aspx?id=1036724&guid=a49c2038-a00e-41b6-a647-3ab6b5dc6ed7&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1036724&guid=a49c2038-a00e-41b6-a647-3ab6b5dc6ed7&scheme=1


RESPONSES TO THE COMMENTS OF THE EDITOR: 

COMMENT: There are image artifacts in the upper left corner of every microscopy image. Please 

remove them. 

Thank you for bringing this to our attention. We believe that something happened during the conversion 

from (.pdf) to (.eps). As we do not see the same artifacts in the original (.pdf)s, we have chosen to upload 

them in that format instead.  Please let us know if this problem persists or if you would like the figures 

saved in an alternative file type. 

COMMENT: Please revise the highlighting of the protocol to be 2.75 pages or less. This is a hard 

production limit to ensure that the videography can occur in a single day. 

We have eliminated large portions of the highlighted section that refer to walkthrough of software and 

have instead indicated the parent function required to progress in the protocol. (e.g. “Unmix the spectral 

image data.”) 

 

RESPONSES TO THE COMMENTS OF REVIEWER 3: 

COMMENT: In 4.5.1), the authors mentioned the mitochondrial label may have different optimal 

staining concentration/time depends on the color or brand. Could they specify the specific 

color/brand was used here? 

We had brand names and colors in the original draft of the manuscript but were advised by JoVE that 

commercial names shouldn’t appear in the body of the manuscript and should be confined to the table of 

materials appearing at the end. As such, all product names, companies, catalog numbers, and descriptions 

are included in the table of materials at the end of the manuscript to conform to JoVE criteria. 

COMMENT: In 2.1.4.5.6), could the authors explain when should the users consider change the 

"Skip Fr." setting. 

We have added the following note to the instruction of the “Skip Fr.” Setting: “Note that it may be useful 

to selectively skip frames in the event that one or few excitation wavelengths are significantly more 

powerful than others or if individual excitation wavelengths prove to be especially phototoxic.” 

COMMENT: in 5.3), the last word should be "sample" not "same". 

Thank you for pointing this out. It has been fixed. 

COMMENT: In 5.11.2), Could the authors educate the users where to find the detection limit of the 

camera? The authors used an example of 65,535 in this manuscript, but we know different camera 

has different properties. One easy way is to open an image in ImageJ and then open the "image--

>Adjust-->Brightness & Contrast" window. The maximum pixel that can be set is usually the 

detection limit. 

This is a great point. We had previously failed to mention that a histogram containing information about 

the dynamic range is inherently displayed in the bottom portion of the main window of MicroManager. 

However, as this particular substep suggests the user check for overexposure using ImageJ, we have 

included information to check the detection limit in both programs. Specifically, we have added the note: 

“Note that the detection limit of the camera depends on the camera itself. The upper limit is displayed on 

the top right portion of the histogram in the main window of MicroManager. Alternatively, the upper 



limit can be determined by opening an image in ImageJ and navigating to Image > Adjust > 

Brightness/Contrast. Click the “Set” button in the resulting pop-up window, enter an excessively large 

value (e.g. 999,999) in the blank next to “Maximum displayed value”, and click the “OK” button to 

continue. The maximum value displayed in the new histogram should be the upper detection limit of the 

camera.” 

COMMENT: In 6.1.1), Could the authors describe in detail the steps to perform background 

subtraction in MATLAB or ImageJ. 

Rather than describing how to script the necessary code or develop the appropriate linear algebra, we 

have chosen to include MATLAB code that will be available on our resources website and describe, in 

detail, how to use that code for background subtraction and image correction, much like we did in section 

6.3 to describe the steps for spectral unmixing.  

 

RESPONSES TO THE COMMENTS OF REVIEWER 4: 

Thank you for your concise summary. 


